
Introduction

Microsoft Excel is a spreadsheet application. It is one of the core applications found in 
Microsoft Office. Because Microsoft Office controls more than 90% of the market, it is 
important to know how to use Office applications. Excel has been mentioned as a key 
application to learn.

Definition: Spreadsheet is a computer application for the entry and analysis of data in 
tabular form. It is a computerized version of an accounting worksheet, but it is far more 
flexible and useful than a paper worksheet. It can be used to collect and analyze data of all 
sorts.

Start Excel now by clicking on the icon that represents it in the Windows Task Bar at the 
bottom of the screen.

Next up: The parts of Excel.
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In this Course

This is what we will be studying in this course. We will do as much as we can in the time 
allotted, and continue our weekly sessions until we have completed the course.

One of the advantages of using the Microsoft Operating System is that certain things are 
common throughout all of the software. For example, if you want to select all the data, 
press Ctrl + A. To copy something, select it and press Ctrl + C.  To paste, place the cursor 
where you want the pasted thing to go and press Ctrl + V.   If you wish to undo the last 
step, press Ctrl + Z.

It works that way in all of the other Microsoft Office applications too. 

In Excel, there are similar concepts. Learn to identify them and use them. If you learn the 
concepts of the software, when the time comes for you to learn something new about it, 
you have an advantage in learning the new skills. From this point onward, learning new 
skills, new things to do with the software, is going to be a regular part of your life. The 
changing demands of business require it.
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Prerequisites 

There are just two prerequisites for this course: basic computer skills and the Microsoft 
Excel 2010 application on the computer you are using. HIREDTexas computers all have 
Office 2010 with MS Excel 2010 already installed on them.

Microsoft regularly upgrades and changes its software. MS Office 2013 and MS Office 2016 
have a slightly different interface than MS Office 2010. 

The difference between Office 2016 and Office 365 is Office 2016 is the installed version of 
the application and Office 365 is a subscription application that resides on the Internet. 
People subscribe to the service for a year, then renew their subscription. Subscription 
applications are becoming popular with software companies. Users are required to pay for 
using an application annually, creating a steady revenue stream for the software company.

You should already know how to start an application. You should be able to save a file and 
find it. You should know how to navigate the file structure of a computer to find files you 
need. This course presumes that you already know how to do those things. If you do not 
have these skills, we recommend that you take the course “Computer Fundamentals” first. 
We will offer that course at a later date.

If you do not touch type yet, get through this course first, then get a good touch typing 
course book or DVD and teach yourself. The author of this course was 40 years old before 
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he learned to touch type after decades of pecking around with two fingers. On the incentive 
side, touch typing is considered a basic skill. You are expected to be able to do it.
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When you first start Excel it will prompt for a  new blank document or show you the last 
set of Excel documents your opened last week.
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Creating/Opening Excel Documents

New:  If you need a blank spreadsheet, click  on the first icon in the grey pane.  If there is a 
template that you need, select the appropriate template.

Open Existing: If in the green pane, double-click the filename.  Otherwise, click ‘Open 
Other Workbook’ in the lower left-hand corner and browse to the file you wish to open.

In the upper right-hand corner, you will see your name and email address you registered 
the software with.
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Managing Spreadsheet Tabs
An Excel document consists of one or more spreadsheets.  The spreadsheets are shown as 
tabs along the bottom of the document.

When a new Excel document is created, a default number of sheets will be created with a 
name of Sheet1, Sheet2, etc.  The number of sheets created is specified in the Options 
section under the File tab.  We do not cover the setting of options in this course.  But you 
can review them at your leisure.

If you right click on any sheet name, it will bring up a list of possible actions.
• Inset a new sheet
• Delete the selected sheet
• Rename the selected sheet
• Move or Copy the selected sheet
• View Code of the selected sheet – advanced action
• Protect the selected sheet – advanced action
• Set or Change the color of the selected tab
• Hide the selected tab
• Unhide tabs
• Select all tabs

• You can also add  a new sheet by clicking on the insert dropdown in the cell section of 
the home tab.

• You can also click on the + next to the last sheet shown to add a sheet.
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The Parts of Excel Window:  Control Ribbon – Formula Bar

When you open the Excel application, you see the Excel spreadsheet window. 

At the top left-hand  corner, you have the quick ribbon.  This shows the most commonly 
used functions.  You can click the dropdown to add additional commands.

Across the top is a ribbon with controls. The ribbon has tabs. Clicking on a tab reveals 
different ribbons. Each tab has a control ribbon with functions applicable to that tab.

The Home tab has the basic controls for the spreadsheet. The Insert tab shows things that 
can be inserted into a spreadsheet. The tabs to the right of that reveal controls more 
specific to spreadsheets and the manipulation of data. We will discuss some of the basic 
controls, then talk about the rest of controls when we get to them in the course.

Below the control ribbon are two smaller panes. 
● The one on the left displays the cell address of the current active cell. We will talk 

about cells next. 
● The one on the right is the Formula Bar. You may write formulas in the formula 

bar. If you select a cell with a formula in it, the formula will be displayed here. If 
you want to edit a formula, it must be edited in the formula bar. We will talk about 
formulas in a while.
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Excel Window - Columns and Rows

Just below the formula bar, a row of Column Letters that stretches across the screen. 
Columns have letter names.

On the left, a series of Row Numbers descends on the screen. Rows have number names.

Remember: Rows are numbered, columns are lettered.
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Cell Addresses
Let’s spend a little time on the geography of a spreadsheet. 

Spreadsheets are made up of:
● Columns run up and down on the page. They are lettered: A, B, C and so on.
● Rows run across the page. They are numbered: 1, 2, 3, and so on.
● The intersection of a column and a rows called a cell.

○ A cell address of D5 represents the cell that is at the intersection of 
column D and row 5.

○ A cell may contain text, number or a formula. 

Pop Quiz: if the maximum number of rows is 1,000,000 and the maximum number of 
columns is 16,000, what is the total number of cells in a maximum spreadsheet? 

Can you use Excel to get the answer?.
Answer: 16 billion
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Excel Controls – Cell Selection

Commands used in Excel have some things in common with other Microsoft Office 
applications, such as Word and PowerPoint. To act on a cell, or group of cells, they must be 
selected. Selecting a cell means to use the pointer to point to the cell then left click the 
mouse. A cell is selected when a green line appears around a cell. 

A group of cells are selected by pointing at a cell, left click and hold the mouse button, and 
dragging the pointer with the mouse until all the cells to be selected are inside the green 
line. Note: that the upper left cell remains clear while the rest are covered in gray. A group 
of cells is called a Range.

Releasing the left mouse button leaves the cells selected.   To deselect the(se) cell(s), click 
in another non-highlighted cell.
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When you click on the File Ribbon it defaults to the open option.  This will allow you to 
open an existing file. 
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The New option allows you to decide what type of file you wish to open.  It can be a 
blank file or a specialty template.
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The first time you save a file, you will use the Save As option because you need to give 
he file a name.  The save option saves all of the changes since the last time your 
saved the file.
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The print option allows you to print the spreadsheet.  You can also save a file as a PDF 
(Portable Document Format).  This is also where you can set how the page(s) can be 
laid out before printing.
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Home Ribbon: Excel Controls – Clipboard section (Cut, Paste, Copy)

The first section under the Home tab is the Clipboard.  Clip Board is a temporary memory 
where data that is cut or copied is stored. 

The scissors is the Cut function. When a cell is selected and Cut is clicked the data is copied 
into the Clipboard. Cut is a way to move data on a spreadsheet from one cell to another.

The double paper is the Copy function.  When a cell is selected and Copy is clicked the data 
is copied into the Clip Board.

The contents of Clip Board are released with the Paste command.

To Paste the data, select an empty cell and click on the Paste button, if you want to have 
the same information that was either cut or copied.  If the data was cut, it will be moved to 
the new location.  If the data was copied, it will be duplicated in the new location.
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Cut & Paste Practice

1. Select Cell B2.
2. Type 1234 into the cell.
3. Click on an empty cell.
4. Select Cell B2 again.
5. From the Home Tab ribbon, select Cut.
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Home Ribbon: Excel Controls – Font section (Fonts & Sizes)

Fonts includes text and numerals. Fonts may be chosen by name using the drop down 
arrow to the right of the font name. For spreadsheets, fonts should be chosen for 
maximum clarity, such as Calibri, Arial, or Verdana. Decorative fonts should be avoided. 

Font size, to the right of the font name, can be chosen by clicking on the drop-down arrow 
to the right of the number or by using the two A’s (1st Larger A - increase, 2nd Smaller B -
decrease).

If you wish to change the text type, font style, size, underlining, text color and apply an 
effect, you can click the arrow in the lower right-hand corner of the font section.
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You can change the appearance of the text by either Bolding (B), Italicizing (I), and/or 
Underlining (U). 
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The box, to the right of the underline, allows you to add various types of borders
around the cells.

You can click the dropdown to obtain additional changes to the borders.
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The bucket with the Yellow line under it is the highlighting feature. Clicking on the down 
arrow, allows you to change the color.

The A, with the red beneath it, is the text color. Click the dropdown to change the color.
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Font Practice

1. Select cell B5.
2. Type your first name into 

this cell.
3. Select cell C5.
4. Type your last name into this 

cell.
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Alignment

These buttons enable the position of text or data within a cell, or group of cells. The 
buttons on top row aligns the data vertically. The buttons on the bottom row aligns the 
data horizontally. 
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Alignment - Angled Text

Sometimes it is advantageous to angle text in a cell.  Most of the times, this will be on 
charts for the label of the types of information found on them.
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Alignment – Text Orientation

Clicking on the down arrow for the Text Orientation command reveals this dropdown 
menu.

28



Alignment - Shift and Wrap Text

These two buttons enable the shifting of text in a cell to the right or left.

When text spills out of a cell because it is too long, clicking on Wrap Text will enlarge the 
cell vertically to fit the text.

The two images, in the smaller box, will either shift the text to the left or the right within a 
cell.
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Alignment - Merge and Center Cells

The Merge and center, allows you to center a heading of a set of data.  Click the dropdown 
arrow for the types of Merge and Center.

Note: Only the left-most data will be left in the cell.  All other data will be lost.
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The next section of the Home ribbon is the Number section.  This section allows you to 
determine what type of number you have and format it accordingly.

If you click the dropdown arrow, it will give you more options.  The default is General.  
However you enter a number, it will either make it an integer (no decimal point) or 
if you add a decimal point it will keep that format.
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Data often comes incomplete. Then it is necessary to insert a cell, row, column, or even a 
new sheet. 

On the Home Tab, in a section called Cells, there are three useful buttons.  Insert is the 
first one.
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Regardless of if you choose Insert Cells, Sheet Rows or Sheet Column, you will get the same 
insert dialog box.

The data can be shifted the right or down from the current position.

Inserting a Row: When you select a whole row, click on the row number, and click the 
Insert button will insert a whole row above the selected row.
For example, select row 2, select ‘entire row’ and Ok button, and it pushes down and a 
blank line is inserted above this information.

Inserting a Column: When you select a whole column, clicking on the column letter, and 
clicking the Insert button will insert another whole column to the left of the selected row.
For example, select column B, select insert then ‘Entire column’ button and Ok button.  A 
blank column is inserted to the left of this information.

Inserting a Sheet: When you need to add a new sheet, it will add a new sheet to the left of 
the current sheet.
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Regardless of if you choose Delete Cells, Sheet Rows or Sheet Column, you will get the 
same delete dialog box.

The data can be shifted the right or up from the current position.

Deleting a Row: When you select a whole row, select the row, and click on the row 
number, and click the delete button. It will delete the current row and shift the row up.
For example, select row 2, select delete and entire row and row 3 is now row 2.

Deleting a Column: When you select a whole column, click on the column letter, and click 
the delete button.  It will delete the whole column and shift the rest of the data left.
For example, select column B, select delete then ‘Entire column’ button and Ok button.  
Column B will “disappear” and the data from column C will be in column B.

Deleting a Sheet: When you need to delete a sheet, it will delete the whole sheet.
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Formatting Button

The third button in the Cells Section is Format.

Format’s dropdown menu numerous controls. Here are a few of them.

Row Height enables you to establish the height of a row.
Column Width enables you to establish the width of columns. If you wish, you can 
establish a default column width for the whole spreadsheet.
Hide and Unhide allows you to keep information from prying eyes.
Tab  Color allows you to set the color  of similar tabs
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Format - Hide and Unhide

You will want to use the Hide function when you need to move unnecessary data out of 
the way but do not wish to delete that data.  You can use the Unhide function when you 
are done and you want to display the data again.

To hide a column or row, select the column or row to hide. Choose Hide Column from the 
dropdown menu under the Format button or right click and select ‘Hide’.

There is a catch.
Note that the column or row may not be in view, but the sequence of the columns – A-C 
rather than A-B-C or row reveals the fact that a  hidden column exists. The same thing is 
true if you hide a row. While the row is no longer in view, the sequence of row numbers 
shows that the row is hidden.

Why would we use hide and unhide? Here are two:
1. To show only relevant data in a report.
2. To made data adjacent for charting purposes. If you were making a line chart, 

for example, and each column represented a year, and the data you needed 
came from every other year, you could hide the columns from the years you 
did not need and the charting system would ignore those years when creating a 
chart.

37



Changing the width of a column/row

When a cell is formatted as a number rather than text it cannot be wrapped.  Therefore if 
the contents do not fit in the current cell width, a value of  “#####” will be used to indicate 
that there is not enough space.

You have a couple of  options
• Change the font to a smaller size so that it will fit
• Change the width of the cell ‘s column/row to allow it to fit.

One way to change the width of a cell:
Place the pointer over a vertical column separator of the  table. The pointer will change to 
this symbol.  Click, hold and drag the vertical to new position. Release the mouse button to 
complete the move. Change the other column widths the same way. 

The first row of the table should look like this.

You may also place the pointer over the vertical column 
separator of the table and click the left mouse button.

Changing the height of a row works the same way.
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AutoFill

Fill data into adjacent cells by using the fill handle
To quickly fill in several types of data series, you can select cells and drag the fill handle 
(the green box in the lower right-hand corner). To use the fill handle, select the cells that 
you want to use as a basis for filling additional cells, and then drag the fill handle across or 
down the cells that you want to fill.

This works with numbers, months, days of the week, years, quarters or any text that can 
create pattern.
Note:  Autofill does not appear to work with letters.
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AutoFill – Options Dialog

The Autofill Options Dialog lets you change how the autofill works.  Create a list.
You can select to:

• Copy Cells
• Copies the initial value into the adjacent cells

• Fill Series
• Fill the adjacent cell with a series based on the original selected cells

• Fill Formatting Only
• Copies the formatting only – similar to Format Painter

• Fill Without Formatting
• Fills the adjacent cells without copying the formatting

• Fill Months
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AutoFill - Adjacent Fills

Different series may be filled at the same time. The requirement is that each fill increment 
the same.

For example, numbers increment at 1, that is 1, 2, 3, 4.
Months increment at 1, Jan, Feb, Mar, Apr.

Enter the data that will be filled. In this case, 1 and Jan.
Select both cells and use the fill handle as before.
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Fascination Formulas
Begin with Equal

In Excel, every formula begins with this symbol: equal. The equal sign signals that the 
information to follow is a formula, not data. 

What comes next is the formula proper.

Your first step is always to select the cell in which the answer will appear.
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Numeric Formula Example 1

The symbols (notations) we will be using are the common operator symbols. The operator 
symbols are plus (+), minus (-), multiply (*), divide (/), exponents (^)

The asterisk is the symbol for multiplication.  It is placed between the two numbers to be 
multiplied.

It looks like this in a numerical formula. Twelve times twelve equals 144. The result for the 
formula is displayed in the cell in which the formula is written.

The formula in the cell is visible in the formula bar. The result from the formula is visible in 
the cell.
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Algebraic Notation Formula Example 1

If we write the same formula in algebraic notation (using cell references), we substitute 
the actual numbers for the cell address
. 
Algebraic notation represents the relationship between the two cells. Cell D2 is to be 
multiplied by Cell E2.

Notice the formula in the formula bar is different from the previous example but the result 
is the same.
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Numeric Formula Example 2

Let’s divide 144 by twelve. Using a numeric formula, we write =144 forward slash 12.

You can see the formula in the formula bar and the result of the formula in cell F4.

Let’s convert this formula to algebraic notation.
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Algebraic Notation Formula Example 2

Using algebraic notation, we use cell addresses instead of numbers in formulae. In this 
case, we start with cell F2 and divide it by cell D2.

Algebraic notation enables us to describe the relationship between the cells rather than 
the numbers.

That is very useful. Algebraic notation formulas can be copied on a spreadsheet to solve 
similar problems. Numerical formulas have to be written for each problem.

Let’s look at some more algebraic notation.
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Algebraic Notation Formula Example 3

To  do exponents, you would use the caret (^).  The third way to get 144 is to type the 
formula ‘=12^2’.

Let’s look at some more algebraic notation.

48



Numerical Formula with Parenthesis

A parenthesis in a formula means to do that calculation first. Remember  Order of 
Operations? In this example, we would add 1 plus 4, subtract 2 first, then multiply the 
result by 2. 
If we put this formula in a cell, what number will the cell display? 
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Algebraic Notation with Parenthesis

Here are the same numbers, all arranged in separate cells. 

Write the algebraic notation to do what we did with the last numeric formula. First, add 1 
and 4 together, then subtract 2. Multiply the result of that by 2. Remember: use cell 
addresses instead of numbers to write the formula.  Enter in the following numbers into 
Row 3, Columns D through G.  Take a moment to write the formula in H3.  What do you 
believe it is?

<<<PAUSE for a moment to let the class do this, then ask who has an answer. Let everyone 
who has an answer say it.>>>>
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Algebraic Notation

As good as basic algebraic notation is, it has its limitations in more complex situations. 

This formula adds the values of the cells in the row. The only trouble with it is that it is an 
inefficient way of doing it. 

Excel has a better way. It is called a Function.

But before we get to that,
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Practicing with Formulas

Let’s practice writing formulas in algebraic notation.

Open the folder marked Excel 1 Basic Student Folder. Then open the Excel file named: 
Excel 1 Basic-Student Workbook.xlsx. 

When the file opens, make sure you are looking at the Practice with Formulas
spreadsheet. 

If you are not, look at the tabs at the bottom of the spreadsheet and click on the Formulas
Tab to put you on the correct spreadsheet.

There are six exercises that use the information about formulas we just went over. Do the 
exercises. As soon as people get done, we will go over the exercises. 

CHANGE SLIDE and hold on Animated Gif until ready to proceed.
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Hold until ready to proceed. Prevents burn-in.
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Question 

Enter in these numbers in Col A and in row 16.

We will use these numbers for the next several slides.
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Workbook - Formula 1 & 2

There are two ways to write a formula for Prob 1. One way is to use the actual numbers as 
in this example.

A better way is to use cell addresses rather than numbers. It is easy to check to see if you 
have written the formula correctly. 

In Formula 1,  with data in a column, you would have consecutive numbers in a column.
In Formula 2, with data in a row, the numbers in  the row would be the same, while the 
letters (column) would change.

Note: If you used the function called SUM, that was not what was called for. We are 
writing formulas at the moment. Functions are next.
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Formula 3
Use the data in row 16

There we go again: Stating the problem so the equation is not what we expect. You have to 
think about what you are trying to do before writing formulas. 

The answer to the first problem is 125. The other problems will have different results.
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Formula 4
Use data in col A

This is a little trickier. The first operation is to add the first two numbers together. The 
second operation is to subtract the result from the third number. Remember that to 
indicate an operation is to be done first, we place it into parenthesis.

The correct result is -2. 

BIG TIP: If you have a series of similar formulas with the same number of elements 
performing the same operations, the formula can be copied into the next answer cell. Excel 
will adjust the columns (or rows) as necessary. So once you had written the formula for 
Prob 1, you could copy the formula over to Probs 2 and 3. Provided that you used the cell 
addresses rather than the actual numbers.
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Formula 5
Use data in col A

Here is the formula. Notice the asterisk to indicate multiply.

Extra point question: Does it matter which order number we multiply by in this case? No. 
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Formula 6
Use data in row 16

All three numbers a neatly aligned in ROW in the order they will be used. This one is pretty 
straight forward.

Add the first two together first and then multiply the result by the third number.

Does anyone have any questions on Formulas?

Formulas get easier the more you do them. Remember the formula describes the action 
that is done to the actual numbers in the cells. 

Let’s take a look at Functions. In Excel, a Function can be part of a formula.
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Fathoming Functions 

A function is a word or a combination of letters that represents a particular act of 
calculation. 

Instead of taking all the time to write formulas describing each cell, a function can use a 
notation indicating a range of cells. 

This shorter notation accomplishes the same task as the much longer formula in the earlier 
example.

To sum up, a function is a word or a combination of letters that represents a particular 
act of calculation. 
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Function Resources

Functions can also be selected by clicking on the Formulas tab on the Ribbon. Here the 
Functions are grouped by area of interest: Financial. Logical, Text, Date & Time, and so on. 
Clicking on one of the buttons yields a drop-down list for that category. Just click on the 
function you need. 

In practice, functions group around specific types of work: Financial analysis, data analysis 
and so on. You will accumulate the functions you use most often in the Recently Used list. 

Hovering over a function will bring up a description of the function.

Another good resource is the Internet. 
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Function and Range

You will remember that a range is a notation that includes a opening parenthesis, the first 
cell to be included, a colon, the last cell to be included followed by a closing parenthesis. A 
parenthesis indicates it is to be calculated as a unit. Ranges are used extensively in 
functions.

Excel has hundreds of functions. To make it easier to use them, functions are grouped by 
the kind of work to be done. For example, there are Financial, Date & Time, Math & Trig, 
Statistical, Lookup, Database and many more. Typically, you will learn to use the functions 
that apply to your job and ignore the rest. 

This Function has the purpose of adding the numbers in the range of cells together.
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Range

Before we get to Functions, there is one more concept we need to understand called 
Range

A range is a number of adjacent cells in a row or a column. It can include cells in multiple 
rows and columns. When we write a range, we start with an opening parenthesis. Next is 
the cell address of the first cell in the range, a colon, then the cell address of the last cell 
in the range. Add a closing parenthesis and the range notation is complete.

When we use a range, we apply the operator (plus, minus, multiply, divide, or a function) 
to all the cells in that range.

(A3: D3) indicates a range that stretches from the cell A3 to the cell D3 and includes all the 
cells in the row between. 

Note: The parenthesis means to first consider the range as one thing.

(B2:B8) indicates a range that stretches from the cell B2 down the column to B8.
(A2:B8) indicates a range that stretches from the cell A2 down the rows and across the 
column to B8.
Handily enough, ranges work with Functions, too.
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Range Selection

Holding down Shift Key plus the arrow key will allow you to select a range of data.
By hitting the right arrow while holding the Shift Keys – you select the columns of data.
By hitting the down arrow while holding the Shift Keys – you select the rows of data.

By doing each, you will get both the columns and rows with data.
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Function Dialog Box

Finding a function is easy. In this case, we want to add a row of numbers. You can find the 
functional dialog box 2 different ways. One way is to click the fx button (click mouse).  The 
second way is to go to the formula ribbon and click insert function.

1. Select the cell where the answer is to appear, in this case, cell H3. A bold line will 
appear around the cell to indicate it is selected.

2. Open the function dialog box. 
3. A dialog box appears. There are three ways to find a function. 
(click mouse)

First, use the search pane at the top of the dialog box. Type in a brief description of what 
you want to do. Click the Go button and the result is displayed.
Second, choose a category, such as Financial, to display those functions.
Third, select All as the category and scroll through all the functions. 

4. For this exercise, let’s presume we want to add a row of numbers together, so click on 
the function SUM.

5. Click OK at the bottom of the dialog box.
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Function Arguments

When we talk about arguments in math, we are talking about the specific notations we are 
going to use. 

The Function Argument dialog box is a place to enter those numbers. When you place your 
cursor in the appropriate box to add the formula, it will determine a range for you.  The 
box has fields for two sets of numbers, but you do not have to use both fields. In this case 
we will use only one field. There is the hard and the easy way to enter the numbers. Let’s 
go with the easy way.

If there is no range already entered, click on the up arrow button Number1 pane. This will 
minimize the box so that you can select the data.
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That results in a small dialog box like this.

1. Left click and hold (with your mouse) and drag it across the range to select it. Notice 
the marching ants that indicate the selection. 

2. When you have selected cells A3 through G3, press Enter. That returns you to the 
Function Arguments dialog box.
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Function Arguments
1. Note how the range is repeated in cell H3.
2. Below, the larger box indicates confirming information of what you are doing:

a) Adding all the numbers in a range of cells. The total is 70.
3. Click OK to complete the computation. 
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Results

The sum of the numbers appears in cell H3, which was selected for the formula.

Because H3 remains selected, the formula in the cell appears in the Formula Bar.
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AutoSum

Summing a column or row of numbers is a common task,  so Excel has made it easy to get 
the result you need. 

TIP: You can click on any empty cell, click AutoSum, then select any range of numbers 
anywhere on the spreadsheet and sum them.
AutoSum will default to a range that is contiguous with the selected cell.

The Tool Tip opens when you hover over the button without clicking on it.

BIG TIP: All of the controls on the ribbons have Tool Tips.

1. Select the cell at the bottom of a column or to the right of a row of numbers.

2. Click the AutoSum button. The column or row of figures is selected.  Excel will select 
contiguous cells which contain numbers.  The selection will stop at the first blank cell.  You 
may choose to accept the range selected or change it using the mouse.

3. Press Enter and the column/row is summed. 
This Eliminates the steps required when working through the SUM function with the 
Function Dialog Box.
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Selecting the drop down button allows you do choose other functions 
• Sum
• Average
• Count Numbers
• Max
• Min

• The ‘More Functions’ will take you to the Function dialog box

Warning: Excel has a preference for selecting the range from a column rather than a row.
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Practicing with Functions

It will be easier to do the exercises if you always use the function button next to the 
Formula Bar to begin. The purpose of the exercises is to learn how to use the function 
dialog box to select the function, except in problem group 4. 

In problem group 4, find a button on the ribbon in Home tab that can add up the numbers.

As we did before with formulas, when the class is through with the problems, will go 
through them so you can grade yourself.

INSTRUCTOR: Change Slide and hold until ready to go through the problems.
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Question
Enter in the data in row 11

We need to count the number of  cells that have numbers in them.  What function do you 
think we can use?



Averaging

Remember the order of the process:
1. Click in the cell where the answer will go.
2. Click the fx button to the left of the formula bar.
3. Select the function you need.

Get used to going to the dialog box to select functions. You can search for a function by 
using a description in the search box, or you can reuse a function you have used frequently 
by selecting it in the Selection pane. Below the Selection pane is a description of what the 
selected function will do. 

For example, the AVERAGE function returns the average of its arguments.
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Workbook Functions – Group 3 - Date and Time functions 

This is one you had to find on your own using the Function dialog box. Which function do 
you believe you should use? The NOW function delivers the current date and time into that 
cell.  (click)

There is one thing to know: this is a volatile function. That means it recalculates what now 
means based on the settings for calculation for Excel. In practical terms, when you first use 
the function, you will get the current date and time. If you open the spreadsheet again 
tomorrow, the NEW current date and time will appear in the cell.

If you were to print a spreadsheet, it would be a date and time stamp for the printing. 
Because you may print a spreadsheet several times, it would provide a way to separate 
one printing from another.

The other date and time capabilities of Excel can be fun. 

If you are planning a project, knowing the number of working days available is important. 
Excel’s NETWORKDAYS function can calculate that for you. If a process takes 123 working 
days to complete, you can figure out how many actual weeks it will take to reach 123 
working days taking weekends and holidays into account.
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We need to count the number of  cells that have numbers in them.  What function do you 
think we can use?



Counting Data

There are two possible answers for this task.

The COUNT function counts the number of cells in a range that contain numbers only. That 
is especially helpful when some of the cells in range contain numbers and others contain 
letters (does not count cells with numbers AND letters).

The COUNTA function counts the number of cells in a range that are not empty. This is 
useful when using a letter to indicate attendance on a date. If you had a grid where the 
columns represented dates and the rows represented students, you could mark students 
present by putting an x in the cell for that date. Counting the range that represented one 
student would tell you how many classes they attended.

Either one of these functions would be able to do the task assigned.
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Counting Selected Data

Here is a scenario: A particular health test yields a range of readings from 0 to 68. It has 
been determined that anything higher than a reading of 65 is abnormal. We have a group 
of 660 tests to check to see how many of them are abnormal. We want to count a result if 
it is greater than 65. 

The Function is COUNTIF. First we select a range of numbers, then enter a criterion to test 
the number to see if it should be counted.

1. Click on the fx button on the formula bar.
2. Find and select the function COUNTIF.
3. Click OK
4. In the Function Arguments dialog box, click on the red dot button for range.
5. Click on the first number of the range in the upper left corner of the table and drag to 

the last number in the range in the lower right of the table. A range can include 
multiple rows and columns. 

6. Click on the red dot button. This returns us to the Function Arguments dialog box.
7. Click on the red dot button for Criteria.
8. Using the Greater Than Symbol >, enter >65. We want every result higher than 65 to be 

counted. 
9. Click on the red dot button. This returns us to the Function Arguments dialog box.
10. Click OK. 
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This method counts only cells with numbers in them. Empty cells, or cells with letters, are 
not counted. 
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Formatting Cells

Cells can formatted to show information in the best way. Just click on a cell, right click and 
a drop down menu appears. Choose Format Cells from the menu.
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Formatting Numbers

Excel can format numbers to accommodate any kind of calculation it can make.

the number format, for example, can be used to standardize on the number of integers 
past the decimal point. It can also separate a number at 1,000 with a comma to make them 
easier to read.

Whole numbers are non-fractional, positive numbers. An integer is a non-fractional 
number either positive or negative. 

Other formats include currency, accounting, date, time, percentage, fraction, scientific, 
text, special, and custom. 

Another way to get to this is from the HOME tab in the Number section.

81



Formatting Numbers using HOME Tab buttons

The HOME Tab has selections for formatting numbers.  There are both a drop down 
selection and quick access buttons.
CLICK

The dropdown includes:
• General: number without decimal point
• Number: adds decimal points
• Currency: adds dollar symbol and cents
• Accounting: similar to currency
• Short Date:  date in format MM/DD/YYYY; if given a  number, date is the number of days  

from 01/01/1900
• Long Date: day of the week and date in format MM/DD/.YYYY
• Time: time  if format of hh:mm:ss AM/PM
• Percentage: takes the number, multiply by 100, and adds % symbol
• Scientific: converts the  number into scientific notation
• Text: treats all numbers as text and left justified
• More: gives your more options for each type of number format

• The buttons allow you to quickly select Accounting, Percentage and increase or 
decrease decimal points.
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Text Alignment

These buttons enable the position of text or data within a cell, or group of cells. The 
buttons on top position the data vertically. The buttons on the bottom position it 
horizontally. 

The Dialog box will allow more control selections.
• Horizontal
• Vertical
• Indent
• Wrap Text
• Shrink to Fit
• Merge
• Text Direction
• Text Orientation

Wrap Text can also be selected from the Home Tab.
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Wrapping Text

When a line of text is too big to fit in a cell, there are several things you can do. 
1. The column can be widened to reduce the depth of the cell.
2. Another option is to reduce the text until it fits the cell.
3. The best solution is to wrap the text. 

Wrapping text adds as many lines as necessary within the cell in the column to fit. This can 
result in a tall cell. 

Wrap Text can also be selected from the Home Tab.
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Borders

Ordinarily, the borders of a cell do not print. They have to be formatted first.  If a range of 
cells is selected, borders can be drawn around the edge of the selection, or around every 
cell in the selection. Here is how to do it:

1. Click on the border tab.
2. Choose a line style.
3. Choose a line color
4. Choose one of the presets or
5. Choose each of the sides individually
6. Click OK.

85



Formatting Borders using HOME Tab buttons

The border options can be found in the Font section on the Home tab. There are both a 
drop down selection and quick access buttons.
CLICK

The dropdown includes:
• Bottom Border
• Top Border
• Left Border
• Right Border
• No Border
• All Borders
• Outside Borders
• Thick Box Border
• Bottom Double Border
• Thick Bottom Border
• Top and Bottom Border
• Top and Thick Bottom Border
• Top and Double Bottom Border
• Draw Border
• Draw Border Grid
• Erase Border
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• Line Color
• Line Style

To have more options, click on the More Borders option .
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Formatting Colored Fill

To add a colored to a cell(s), 

1. Select the cell(s).
2. Right click.
3. Choose Format Cells from the dropdown menu.
4. Click on the Fill tab.
5. Click on the color desired for the fill.
6. Click OK. The color background is applied to the cell.

Another way is to right click on the paint bucket in the Font section on the Home tab and 
select a color.
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Format Painting

This is a big time-saver when you need to format a lot of cells the same way. It is fun and 
easy to use.

1. Click on the cell(s) that is formatted the way you want the other cells to be formatted.
2. Double-click on the Format Painter button. It is just under the Clipboard section on the 

Home tab. Note how the pointer gets a paintbrush to the right of it.
3. Click and drag to select the cells to be formatted. The formatting is transferred 

accurately and quickly to them all.
4. The pointer will continue to format any cell you click on until you press Esc. Make sure 

to confirm that the paintbrush icon has disappeared from the pointer.

A Single click on the Format Painter will keep the formatting painter active for one 
selection.
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Formatting Protection

Cells may be locked or hidden using this feature. However, the worksheet must be 
protected for the settings to take effect.

Go to the Student workbook and complete the exercises in the Format tab.
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In the student Excel workbook, find the tab marked “Formatting” and complete the 
assignment. We will be back in a few minutes and show you the outcome.
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Formatting - Numbers

This is what your results should look like. Any questions?

Note: The value for 1D has a leading space.  This causes the selection of Accounting to 
create an error. 
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Number Formatting Error

The contents of cell for 1D has an error which is identified by the Exclamation Point 
symbol.

Clicking on the error symbol will cause a new dialog to display.  The new dialog box gives 
choices about how to handle the error.

Convert to Number will remove the leading blank and store the value as a number.  This 
will allow the cell to be formatted as Accounting.
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Formatting - Aligning Text

Here is what the exercise in Aligning text should look like. Any questions?
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Formatting - Fonts

In  Col A, that can be any font than the one used in the rest of the spreadsheet.

As for the others, are there any questions?
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Formatting - Making Borders

Here is what the border exercise should look like. Any questions?
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Formatting - Coloring Cells

Here is what the coloring cells exercise should look like.

What colors enable you to see data better? Which colors hide data?

Any other questions?

96



Formatting - Format Painter

Notice that the format changes included the type of numbers, the font size and type, and 
color fill for the cells.

Are there any questions?
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Charting Building Blocks

Building tables of data is useful for analysis, but less so for presentation. Presentations 
need to have charts. Charts analyze data and present it visually. Fortunately, Excel provides 
a series of great tools for charting that use the data collected in the spreadsheets.

Different kinds of charts best for presenting different kinds of data. We will cover three of 
the most commonly used kinds of charts: Column (click), Line (click), and Pie (click).
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There are several types of charts. Going from left to right, top to bottom

1. Column or Bar chart
2. Hierarchy Chart
3. Waterfall, Funnel, Stock, Surface, Radar Chart
4. Line or Area
5. Statistic Chart
6. Combo Chart
7. Pie or Doughnut
8. Scatter or Bubble
9. Maps
10.PivotChart
11.3D Map
12.Sparklines

a. Line
b. Column
c. Win/Loss

13.Slicer
14.Timeline

We are going to learn about 3 major types of charts: column, line and pie
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Creating a Column Chart 

A column chart is used to compare values for specific time periods. 

In this case, the number of widgets produced per quarter is compared for four years, 
2010 through 2013. The data table is arranged in 5 columns and 5 rows.

In particular, notice how the data table is laid out. Quarters are arranged in rows. Years 
are arranged in columns. A data table must be arranged this way to get the desired result. 
The data you get at work may not be arranged this way, so it will be up to you to re-
arrange the data.

Note: When creating this chart, select only the quarters and year’s data in the table as 
shown by highlighted box. Exclude the yearly totals. 
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Selecting Non-contiguous Data

If we want only the 2010 and 2012 data (don’t forget the Quarters to be included as 
labels.)

• Select the data with the quarter and 2010 information.  Notice that some of the 
titles are included.

• Press and hold the CTRL key
• Using the mouse, (or  ) select the additional columns of data to be included ( 

2012 title and numbers)
• Notice that now all of  Quarters, 2010 and 2012 are highlighted (in blue for this 

case)

Now you can create and format your column chart.

Excel 1 Basic 7/2014
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Column Chart Parts

The parts of a column chart are: 

Select
1. Data Series 2010, Point Q1
2. Data Series 2011, Point Q2
3. Data Series 2012, Point Q3
4. Data Series 2013, Point Q4
5. Title
6. Legend
7. Horizontal category axis
8. Vertical value axis
9. Value Axis Major Gridlines
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Creating a Column Chart 

1. Click on the Insert Tab on the ribbon. This brings up the charting controls.
2. Click on the Column button in the Charts section of the ribbon.
3. Click on the first 2D column chart button.  Excel will create the chart.
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Chart Style

Our chart does not look quite complete. It needs a title at the top to tell the viewer what is 
being shown. 
1. To add a title, click on the chart. The design tab opens up.
2 The ribbon revels new chart tools. In the Chart Style section, Click on the first button.
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Adding Elements to a Chart

• Axes
• Primary Horizontal
• Primary Vertical
• More options

• Axis Title
• Horizontal
• Vertical
• More options

• Chart Title
• None
• Above the Chart
• Centered Overlay
• More options

• Data Labels
• None
• Center
• Inside end
• Inside base
• Outside End
• Outside Callout
• More options
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• Data Table
• None
• With legend key
• No legend key
• More options

• Error bars
• None
• Standard error
• Percentage
• Standard deviation
• More options

• Gridlines
• Primary major horizontal
• Primary major vertical
• Primary minor horizontal
• Primary minor vertical
• More options

• Legend
• None
• Right
• Top
• Left
• Bottom
• More options

• Lines (Line charts only)
• None
• Drop lines
• High-Low Lines

• Trendline (Line charts)
• None
• Linear
• Exponential
• Linear forecast
• Moving average
• More option

• Up/Down bars (Line charts)
• None
• Up/Down bars
• More options
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Chart Title

Now there is a place to put a chart title.  Click on “Chart Title” and type in a new title for 
the chart.

“Widget Production (Thousands)” would be a good title.  Change the size to 20.

Note: You can also type these words in the function bar to complete the title.
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Polishing a Chart

This chart may look good enough, but let’s do some polishing to make it really outstanding. 
The process for each element is similar: 

1. Click on the element to select it.
2. You will get a side menu to do what you want to do.
3. Let’s increase the size of the gridline width to 1.5 and change the color to black.
4. Click on the bars to add a bevel on the columns to make them seem 3-dimensional.  

Change the width to 2.5pt.

A bevel is a 3D object, so let’s take a closer look at the process.
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Axis Changes
The vertical scale
1. Click on the scale and change the maximum axis options to 140.0 (click)
2. Go to the home tab

a. Increase the font size to 12.
b. Bold the numbers (click)

3. Click on the design tab, and Add Chart Element
a. Click Axis Title
b. Click on Primary Vertical
c. Add text ‘# of Widgets’
d. Change size to 16

The horizontal scale
1. Increase the font size to 12.
2. Bold the numbers (click)
3. Click on the design tab, and Add Chart Element

a. Click Axis Title
b. Click on Primary Horizontal
c. Add text ‘Years’
d. Change size to 16

This process is used over and over as you modify the parts of a chart to make it more 
attractive.
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Finished Chart

Notice the differences between the two charts.  (click) Adding the special touches will set 
your charts apart from those who do just the minimum. 

Remember, a column chart is used to compare values for specific time periods. 
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Creating a Line Chart

Line charts are used to compare similar values over time. This chart covers the number of 
widgets produced by calendar quarter for four years. This enables viewers to spot trends.

1. Select the line chart from the Insert tab. 
2. Click on the Insert Tab.
3. Click the Line button in the Charts section.
4. Click on the first 2-D Line Chart icon.

Don’t forget to make the chart look pretty by adding titles, bolding/darkening the axis 
lines, adding color, etc
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Making Pie

(Pause 2 sec) CLICK

Sorry. Got sidetracked there. In the Excel 1- Basic Workbook r9.xlsx file in the Student 
folder, open the 3-Chart Tab.

(Give students an opportunity to get to the location)

A pie chart shows how parts of a total relate to each other. In this case, we want to 
compare the number of widgets made in each quarter with the total number of widgets 
made during the year. This would help us identify which quarter had the largest production 
of widgets. We could make adjustments to materials and staffing required based on the 
comparison.

Making a pie chart begins with the data. Notice how the data is arranged vertically by 
quarters. Arranging the data that way is a requirement for a pie chart.
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Making a Pie Chart

The task is to make a pie chart that compares the numbers of widgets made during the 
four quarters of 2010.  

Select the color data. Make sure to not select the year total. 
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Making a Pie Chart

A pie chart is used to compare parts to a whole. In this case, we are comparing the 
proportion of widgets produced in each quarter with the total number of widgets 
produced during the course of the year.

Question: How could this kind of information be useful in a company? (Give students an 
opportunity to answer.)

Answer: One way it could be forecast to meet the needs of production for the next year. If 
widget parts are cheaper during one part of the year, the parts could be purchased to keep 
costs down.

1. Click on the Insert Tab.
2. Click on the Pie Chart button. A drop down menu of pie chart formats appears.
3. Click on the 3-D Pie Chart on the menu. The pie chart is created on the spreadsheet.
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Pie Chart Parts

Each chart has parts that can be modified. Here are the names of the parts in this chart.
1. Border – this is the edge of the chart area. It can be made wider, and its color 
can be changed just to name two adjustments that can be made.
2. Chart area – this is the background on which a chart rests. The color of the chart 
area can be changed and a bevel added to simulate 3 dimensions. 
3. Data series – the color of the fill can be changed and a data label can be added. 
Data labels are the numbers represented by the data series. For the green area, the 
data label would be 35.
4. Legend - in this case, the legend shows which quarter is represented by which 
color. The letters of the legend can be made larger, changed to boldface just to 
name two changes you can make.
5. Here is your assignment for the pie chart. Using the skills you used to enhance 
the column chart earlier, do these things for the pie chart.
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Chart Formatting

Now’s its your turn to practice formatting a pie chart. Using the skills you used to enhance 
the column chart earlier, do these things for the pie chart.

1. Add a border to the chart.
2. Fill the chart area.
3. Add data labels to the data series. Use quarters and percent.
4. Add a 3-D bevel to the data series.
5. Put a black border around the chart area.
6. Add  a background color to the chart.
7. Remove the legend.

Instructor: Hold on this screen until the students have done their task, then move on.
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Enhancing Charts

Notice that the ways to enhance column, line and pie charts are very similar. 

• Create the chart.
• Point at an element of a chart to be enhanced and right click to get a pop-up dialog box 

with enhancement options.
• Make the needed changes in the dialog box.
• Click OK.

If you know the principles for enhancing charts, you can enhance any chart you can make 
with Excel.

In your student workbook, under the Charting tab, use the data table to make column, 
line, and pie charts.

We will review them when you are done.
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>>>>When everyone is ready, show the three charts.<<<<
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Completed Column Chart

Here is how the column chart should look. Any Questions?
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Completed Line Chart

This is how the line chart should look. Any questions?
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Completed Pie Chart

This is how the pie chart should look.  Any questions?
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We’ve gone thru the Basics of Excel 365 and here’s the recap of what should have 
learned:

1. The functionality of the various ribbons and tabs of the most common ribbons
2. The various parts of an Excel spreadsheet
3. What ranges are and how to define them
4. How to create and use the basic calculations of adding, subtracting, multiplying and 

dividing
5. What the most common functions are like sum, autosum, average, count
6. How to format the cells using fonts, borders, alignment of text
7. How to create the most common types of charts – column, line and pie charts

Now it’s time to practice your skills before you take the final exam.

Do you have any questions before we begin?
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